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4 FEF s EEFIEITEINL, )5 N IKE R -
5 R ILAR TR A

Macintosh (ZE3ChR) F P

1 7 Finder 1 EXGEFTEIHLIC A K

2 X Printer Utility &5

3 7t Web Links &5 1 #.i7 Customer Support.
4 EMulh EIERERIFT EIHLIE N R R .

5 e A BRI AT

THEATERHLERAT (IR T Windows)

RERATTH

1 il © 8 “THA”

2 il “FRERSET o R . AR ISR T T BRSO
3 il “4TERRLER” .

4 JHTEDBL FR SR T L

T EIHLERAF
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5 f& “SCRR7 ENUR TR BT .
6 RIS A TR AT R AT

J8 F B 3BT 2

1 3TIFSCRd, WBERIF el 3o = $TH .

2 il REET . CERIC . W S CCRE

3 75 LT R BB WIS .

A 15 “HRPFTET KEPIE T VW TR L ST RAHAE

5 i B .
BB 2 BT BN
S SR P ST, BT DRI AR . IS LR T W 450047

ENBLBAT tEIAEST EDHLSCA e o i AR AT B L IR S 3T DL A R ILAEST EDBLaE T b, i 2l 2238 0f
BT LR AT IR A

I BT BN A

Windows F /

1 s @ s “FFaR” .

2 il “PTARER” 5L “BBFR7 , ARG WFIR P IERET EOHLRE P S
3 il e k.

4 FERIH SN R LIRS R Z B/,

5 desetelE, EERNE N RTHE L.

Macintosh (ZE3CRR) AP

1 7& Finder i EXGHFTEIHLICAR K
2 X Uninstaller K45 .

3 TR LR ST AR

ZEITEIHL A
EE: WRELIAEIX SN L2238 TIHEIHUR A, (E ST BB 28 8, 1 50 S 22 288 2 A A
Windows F /°

1 SCHI AT FT T R A R I RE Y o
2 FN BRI

T ENHLER AT
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WA b2 )G W ” FURREAT L, EF s et
a i @, dEnd IR, RERE BT .

b 7 “IFHIEER” 8 “iBIT” HEDHA D: \setup. exe, H D E%¥ CD 5 DVD KN 2L 154
Cc fi% Enter ##, st “Hw” .

3 e cxam” St pfe S T ERAE

Macintosh (EXCHR) F P

1 SCH T AT IR R

2 JAFTEIHLINS bR 3 i i 2 e Ry

3 BATIIENHL Rk, ARG F IR S LB L (4R AT 4%
18 FH ELER

TH 3T ENHLAR A4 7] LU k93 support.dell.com 3545 .

T EIHLER AT
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http://support.dell.com

B NARTRAN DS JR A
NG

1 ORIEE AR, el TR EOT.
AL B SR AARIK . AE PRI R R AR TR R A 0] 55

2 EARIKSZARN IR AP R B ARK .
3 HTTHEAR I, A KRR A% .

R WAL AR IEANSTEINLN o AR5 %1 B HUBCE AEAROK SOOI 3R T, JF HARIK AL 2R3 %
HEEMA M AR T .

4 LEFTENHLERAT AR b6 mihf I S I AR5K B

N ARHRAN SR S A
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ARTRARF IR TR 2

BETLIEA.
100 K% i 4%

S

o BEARFPURIEAVKMIIL

o WNEEE B TUA ISR, IEAESTEN 1]k, AR
RTINS TEIHLAY o

25 JKRE M WHEAR FHTEIR— i _E
o BEANFPUREEAUKMIIL
o BIEFET “B3Y” . “IEW” o “BR7 THTE.
R “mdl” B DI, (AR T EUE B R ARk, 41
WA, AREAR. - RADGILR.
20 5K AT o (ERNBIIRAR AT, T AR S A8 I T AT ARk .

o AT W SSAT ENHLE F AR IR 4K

o CREPAIRBEIE AUBCE AT T DL L s, SRS AR U IO
FNFTEHIHLA

o AT PRIEAUKINIL L .

o BAFET “A4ATRIE” ol “Letter BEIE” 4K/

N ARG A S A
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BETLIEA.
10 M &

o BEFENG—T L.
o RSP BN
o GUEFET “BEAT WEITERH.

VERE R ARSI, T DU PR TED, MRS
B0 FA7 i SR PR T E, WSS B T 2 F
i1, SRS SO RN, AT ED, WSRO R
BrF 75 A

o REEFE T IR E G . WERBIR P RAT S8 A R 3R
s THIEFERTR RS, SRR B M A AL BN AT T
LIRS DR A 3T BV A AR BE 4T B R B R IE AR AT & E

25 5RFRZEAC

o BTEN— i L.

o BEARFPURIEAUKNIIL

o BIEFET “B3Y” . “IEW” o “BR7 THE.

R “ml” BT DI, (AR T U B R aRak, 4
MR CAC ARBEAR. JO-RRDGTI 4R,

25 SRBCR LR, Kol k. WIE s A

FHTEIR— i _E
o HATFHPRIER AL,
o BIEFET “B3Y” . “IEW” SRR THTE.
R “mdl” BT DI RE, (AR T EUE B R ARk, 41
WERICAC ARBEAR. - RRDGTI 4R,

25 KM/ St 4R FHTEINR— i _E
o BEARFPUREEAUKNIIL
o BIEFET “B3Y” . “IEW” o “BR7 THTE.
R “mdl” R DI RE, (AR T HUE B A ARk, 4
WA, AREAR. - RADGILR.
10 FRAFL B4R o THIE AL EIHR PREAIELEIAC,

FHTEINR— i _E
o AT PR IEMFLENARININ S .
° :fé‘gii%T « EﬁJ” N “IEPI%‘»” Ei “/B\ﬁ)ﬂ[-” TTEI] )\%o

N ARG A S A
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BETLEA
50 S BN o OB i L
o HEAR L TB IR ML

IRIFERIRERIA I B

T 4T EOR SRR B BRI B3R R . 3K R T B
VR ISR UKEE LS T IT EBUTT 9T B, SLERI L .
1 BT EDHLARARITAR 10 el
2 HHBA R
o R TR AL
a i (o UL “HIRR
b RS AR A (o fi
C RTINSk HHLA T EN LRI ARIR T, AR ¢ (o st
o U TR BRI,
a (o UL “SIRR .
b RIS AT AP (o el
C RTINSk HHLA T EN LRI RI AL, AR ¢ (o b
o R TR BT B B
a ROSLIRIAEE BN | A o
b i [od Bl “TATTEIRY” .
C RTINSk HHLA T B LRI T EL R, 485 e (o el
3 AL DAL, BRI R S LB L.

BN ARHRAN SR S A
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R SO SR A B AE S H B

1 FTOF ARG, ARG R SCR U LE Tl B B E A B
2 PR

N ARG A S A
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T ED

TEIRRN

o R BT BN A T I 2 ) 405K

TR B FT B AR BT B4 2R
TERRIAT BN SR & P AT LW (0 s K

AFTEV R BRI, VSR NS DT T ENHLIE H (3T BN T
TRV R S I BT AR B

T BN A

ITER IS

Windows F /°

1 FTIF kS, MNPt “3CfF > 4TE .

2 i M7 . “EEIm . I B “RE”
3 ERFTEITE . TR E. AREK SRR FT B UL
4 ik “HERE” % T EIHLERAE I ARG AR .

5 Fuli “WhE” 5 “FTEN” .

Macintosh (ZE3CHR) AP

1 FIIFSCRY, MNP H i File > Page Setup.

2 7t Page Setup XJ 1 HE - BCE FT EIFL. AR5K RS FIFTEN T [A) 6

3 Hiidi OK.

4 Mg Hfid §id File > Print.

5 J\ Printer # St b ik FRAE ST BB

6 MATENIETSE R PR EN I FTERG . ARTR 2SRRI Ao 41 EQ 1
7 ‘i Print.

TED
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B AT H)
SIEAS O SCRATEN S G, 0T LSO BT EVE 1 B0 sR# I ST 40— 4UATED CRIEH)
B A

T Hhge

PR
o SUATHEATEN S Gy ORI, SR HTETEIA AT
o YRATENI I, 4 T RIS 7, iE BRI AT BN LR I, S5 SRk 58 TS 1T 2.
Windows f &
1 FTIF kS, MNPt “3CfF > 4TE .
2 il “BME7 . CEEmIC . ETI B CRE” .
3 KRS
“UTENRE” EIR > “E” Xk
4 NEABEITERM L, ARGk “BHITE .
5 il “Whxe” SCHFTENPLERAE I A RHEHE o
6 i “WhE” B “HTEN” .

Macintosh (ZE3CHR) AP

1 FIIF3CRY, S FHREPH i File > Page Setup.

2 7t Page Setup XJ 1 HE - BCE FT EIFL. AR5k RS FIFTEN T [A) 6

3 i OK.

4 Mg Hfid §id File > Print.

5 J\ Printer # S f b ik FRAE I FT EIHL

6 1t Copies Xk N & AT B 2L, SR )5 1L+ Collated.
7 ‘i Print.

18] F7-4T ER

BOEOLY, FTEDHLE BT EN S — 00, SLAEA S8 4 FRUAH S ML T B T, s SRS ) 25— DA, T e b1l LA
TR, LT D R T A

Windows f

1 77030, NN HFR P s “3eft > FTER”

2 il REET L CEBTU . R CRE

TE
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3 AE ITEIRE” GEIRM g0 XA RS T Y
o MIESATE RS — 0, WL “SEATERE R .
o WIEEITEN U, IHBOHIL T “EITERE R .

TR WA T R T, WRARESEAT Bl — 00 ISR TR, b 201 S 25 X
THT,

4 ity W KT ERHLEAE BT A .
5 $EE “m:}_:gn E/Q “*TE]]” .

Macintosh (ZE3CHR) AP

1 FIIF3CRY, MNP sk File = Print.
2 )\ Printer # S B ik £54T EIHL

3 WL, RN A

4 JAFTENE T H S s b $E Paper Handling

5 M Paper Handling 5k, Page Order 5 135 #irp i £64T EN IR -

o WL EN )5 — T, 15i% " Reverse page order &} Reverse.

o UIELFTENSE — 0, HUNIL T Reverse page order & Reverse.
6 i Print.

e 2 TOCHEHT BB — 5k 4K 1

Windows f &
1 FTIF kS, MNPt “3CfF > 4TE
2 il “BHET . CEEmIC . ETI B CRE” .
3 KRS
“TH EDR > “ATR7 R RS > kP CEIREK EHTEBEZ IR
4 EREA B IRA B IR BRSO DU
5 AR AR T BRI BE
6 il “WhE” SCHFTENHLERAE I A RHEHE o
7 il ‘TR B CHTERT .

Macintosh (ZE3CHR) AP

1 FIIF3CRY, S FHREPH i File > Page Setup.

2 1t Page Setup X IFHEH BB FTEINL. 4Rk RS AT EN 7 i) o
3 i OK.

4 Mg pfid g File > Print.

5 J\ Printer it 2 5k PERRIHT EHL
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6 MITERIEIHH 2 b i $ Layout.

7 M\ Pages per Sheet 3. th 32 F ik F/E i — 5K A% E& IR B SO T4k
8 AR R A A B

9 #.i5 Print.

MR BRINAF IR )4 H 3T BN 30 (LR T Windows)
WL “SCPFTE” e

o JTENRLLAUIE USB 188k # i W4 Bete v S HL L.

o STENHURITFE LI AR AT T

o A7fifi R BN AE IS A P AL AT LSRR SO SCAE . 35S 536 0 “ SCRF A il -RAISCAR 2R 3k
HCE 22 145 S

o THEIHL A2 1Rl LASTRFAFAH B # P K SCPESR AL A B R o
1 AL R BN A IR B 25

iﬂEﬂi‘Mﬁi)ﬂU%Uﬁﬁ%&%ﬁ o ATEIHURAR TR s B2 B R “R U BIFE R B0 “R B pE B

2 QURAF B P R SR SCA, ITEIHLRS & B ah e “SCPHTED” #5.
A B o ) I A SORS SO AN G SO, i (o) Fe i “30Rg”
3 JEFEIFFTEISCR

WRITEIHIAE R USB %
a S H S i A B A AT R SCRS (0 SO R4 B e PR SR A T SC A3
b fie (o 458, REH HALIFUE T ED SRS

WARFTEIHLE e (R T IRERS)

a5 S i LG P A ST ED I SCRA 0 3 44 o

b i (o€ ], SRIFAFAIHT ENHLIE S B M 241 SLHLER#48 R o] RO SEL

C UHIUEURI, RS AR P S SN S B, AR $E (o JcHLTFARHT ENSCRY o

EE:
o WERTFSIHLESR YU RS, FTEIHLAT RES S A A VUMRD o 15 10 IR 7435 5 B DX 1R el s A\ TR
.

o WE TSR E TR AU, 12 E TS R R GRS ENHLER A Bl o
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1T BV R3OS

ITEME &

Windows F /-
1 FTTFSCRS, M FHFR P “ 30 > 4TER” &
2 i M7 . “EEIm . I B “RE”
3 KL+
UTENRE” IR > “4UkBM” FHiglk > ke “Hma”
4 RIEFE:
CURIR RS TR HAIER > RS RGBT
WA A RER RS, lES A R
5 EHFTEIT I,
6 il “HhXE” KT EIHLER AR ARG AE .
7 ik “HEE” BCC4TELT .

Macintosh (ZE3CHR) AP
1 FIIF3CRS, SRR H i File > Page Setup.
2 J\ Format for 3l i Sic i P8 O FT ENAIL.
3 J\ Paper Size it ¢ E RIS G B RS
B AT SR AT G E B R, EIE R E R S
4 EPATEN T, K5 Bt OK.
5 M Hiidi File > Print.
6 M\ Printer 3 St b ik FRAE ST EIHL
7 .5 Print.
HE:
o ZRUGFEME R AT ED,
o T HINIELE N IR Pk R T ARIRI BT ED T In)

ITEIRRZE

Windows A/
1 F7IF3CR, MR IR R b ity “3eff > 4TER” o
2 $EE “E,ﬁn . “_é‘iﬁlﬁ” . “iﬁlﬁ” E/Q “_‘&En .

TE
33



3

4

5
6

IR

CHTENRE” LR > “4UKIA7 TRIIHR > R EIRARIKRI

IR

“CHRTK RS TR RAIER > SRR AREK R

UER AT SE AT A ARG R, 1S B T
Ty B G HFT EDHLAAT I T A A
$EE “m:}_:gn E/Q “*TE]]” .

Macintosh (FEICHR) HH

1
2
3

© 00 N o 0 s

10

FITF3CR, AN AR 7 5 File > Page Setup.

M Format for 5L 3¢ 5 o e FERR IR T EIHL

M Paper Size 5 H 3 5k PRI AR AT

N SBAT SE AT E I ARIR RAT, IEIE R E URATS
EPEFTENTT 0], AR5 il OK.

MR L File > Print.

M Printer # S 5 b i FEAE T BB

MFT BN T H 5% #i b % 4% Print Settings 5k Quality & Media.
M Paper Type it 51 i ik £ Card Stock.

M Print Quality 5 Hi 22 i $PEBR Quick Print 2% Draft LA HAF] EJ i &

7 Print.

ﬁ?%%)\ﬁ%i?tﬁ HI3RIR

TR AR B AR T B SR AT EIHLA -
TR AR AR ARG AR 2 B B ARIK A 5 220 1 22K
THHIABEAC P PR SRR R AR 1L 25

VAL e B AR 2R AR WERFRAEARA EHE (S AR%E) , HABIARZE AT RESS

SRR

FTEN B & X R Hygksk
Windows f

1
2
3

4

FITP3CRS, SR rh fals “ 30 > 4TE1Y .
$EE “E,ﬁn . “_é‘iﬁlﬁ” . “iﬁlﬁ” E/Q “_‘&En .
IR

“UTERRE” IR > “4UKIT” TRAIER > fe “ B XRN

MR T R R v I A UGS, RIA Rl “BE” .

TED
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5 i “HaRe” KMHTEIHUER I BT A XHEHE
6 $a:f “m:}_:En E/Q “*TE]]” .

Macintosh (ZE3CHR) AP

1 FTIF3CRY, S FHREPH . File > Page Setup.

2 )\ Format for 3 = B rp e R R R 4T EIAL

3 M Paper Size #1113 #.1 i£ £ Manage Custom Sizes.

4 WHE T E R A H e R, AR5 OK.

5 I\ Paper Size S b EEE QI B e RS, AR5 i OK.
6 Mg HA §id File > Print.

7 M\ Printer # S 5 b ik FRAE ST EIBL

8 i Print.

2 (S

FEIT EDHL LA A A0~ BN A R B 4%

AR M SRS o B AR S22 A T A B e o 8T DUNES AL P B A2, s ATHAR
PLEHCT N IREhas, SRJa HAESm A ST EIPL E.

1 KEAF Al R ARSI B8R A SKEh 2548 A\ USB 2 HH .
WATHER WANFREF

R R
o FEALFAER N R AR A o INAFIXE) AT PictBridge Hht AL RS ] [ —A>
o WHAEMEE AR, EFOAT e R

Wl o LA N AF R B ST N L,

o BT, WEAEE IR Rl e gty S ERCE.
ERLAS T, RJE SRR A

o EHATEDRL R OAERE . 15505536
TSR IAERE BRSO KR 2 115 6

FTED
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BE—TRBIR: MIEAEST BN, B E NAFRE BRI, T AN 2 AT A
ML AT GG RCA AT A7 il BE % s s (3T EDPLIC AR, 5
WA g2 A AR o 2k

2 fElonhE Bk “RBIFEME R BRI BIFEE RS .
EE:
o UnAAT EIHLAAT PUM A B, IR T BEDE A B

o UWIARAFAERIRY P IEA TAERER, IF LG TR IR DN A SXah 2 BB BN K A i S X A B AR B LI A
USB # 1, SoRhi BRI %A R, SR EIEse A LA Mk s

SCRFHIAA R AN SO 2R A
k233 ORI
¢ Secure Digital (SD) R
* Secure Digital High Capacity (SDHC) ® .doc (Microsoft Word)
* Micro Secure Digital (Micro SD) (772G ECA%) ® xls (Microsoft Excel)
e Mini Secure Digital (Mini SD) (7 Z GRS * ppt (Microsoft PowerPoint)
* MultiMedia Card (MMC) * .pdf (Adobe Portable Document Format)
* Reduced Size MultiMedia Card (RS-MMC) (%% | © .rif (Rich Text Format)
A ® .docx (Microsoft Word Open Document Format)
* MultiMedia Card mobile (MMCmobile) (FZI&EHAC | o xisx (Microsoft Excel Open Document Format)
) * .pptx (Microsoft PowerPoint Open Document
* Memory Stick Format)
* Memory Stick PRO * .wpd (WordPerfect)
* Memory Stick Duo (i ZERL#S) {5 .
* Memory Stick PRO Duo (i £iE L% e JPEG
* xD-Picture Card e TIFF
® xD-Picture Card (Type H)
® xD-Picture Card (Type M)

fE AT ENHLER AR AR ST BN AR A
N
2 AT BRI i < et
3 FAAFIR D7 YRE AR Tl AT Gt R B I MO AT L
AP o RN 95 SOR SO R S, IR ST S el JRUE ™, AR o et
8 JRISTHA AR IR " B ATERRRA " ARUE Hk (o€ el

FTE
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EE:

o WA VST EN I, TR CRIERA .

o WURMEA AT 2 e ), THIERE “TENRA T .
5 ST H KA BT ELRO R T, AR (o d

TR T DURSETEN AR R . STEDIrA IR FTEDR S FUYIVE R P RO T G e e 7k ot L0
MR G5 3T B s A RS 3T B A1 2 (DPOF) MR AL 4T BTG IE R A I 7o A 10
FAAB B TS AR DPOF SCfFI, DPOF 1ETA4 2 Bl

6 UHEESTE I
o URVELL T “TRBEIUT T SR, A H SRR LR R AR RS AU A RS IR R SRR T2 R L
L= %41
o UIREALT CHATEIT 7 SR, R ET AL LR R R RO ARk dReRIA L iimT . EOR L
AR AR, IR R IR O RUR . 58— T Jr s 14 (o5 4241

7 i CRA/ BAT EHBER O AT,
ISP O R TR, B R i L R AT R 22258
8 % fuHl.
R ERA AR, VT EN TR D 24 AN, SERERKSE A TR FIHMT S RS .

E T ENHLER AT BN B & B
1 BOURTAR, JFHUAGTTSL AT FTENR— T Lo (NSRRI TR, 2 0 B4R AT

Fo )

2 FATEDNLERAE AR b <2
3 AR L N A IS A s B KA A s B R B AT L

L1 SRAF it V4 o ) BN 25 SORY SCPE RN SO, i 4 (o) Jcdlie e “BRA ©
4 fLILEATENIE

WRITEIHIAE R USB %
o SYIIE AAFAE VAT, B A AT 2 BT T, IR ETHUR L [ SR R A B L
R EH TN

WARFTEIHLEE R (R T RERS)

a R R AL SRR (o j

b 5T I L PR ARAT IR O 2 T WL, AR5 $ (o) 4.
C Rk I

o I AL BRI, PROE IR R PSSR AT T ST SO BT SR R R AR T
SN L BEATEN A
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M PictBridge #AZREAHNLH FTENE
R B AHH LT S HF PictBridge £iAK, n UL VIS HE NSRS AHNLF T ER I, B &8 5L,
1 K USB HL 251 — i iZE 4 AE BUE A AL o
VR 1 FH BE R B AL PR AR USB Hi4s.
2 % USB HLZ5 15— ddi AFT ENALET AT PictBridge #2101+,

EE:

* A PictBridge FEAMMILAHNLE CE N IEFR) USB B, WA IER, B AT GE 2Bl A —
ANNAFIREN S, BE T EIHLERA R TR s 5f BT R B RS B o 15 2 I B AR L W SCRS SRR
EINIENSE

o FTEHURRX R B — P 7 fifi e i

BhE—TTREMBIR: M IELE M PictBridge M7 BCRAHBLH T EDEF, 15 AN fih
L USB WIS ATATMZRIERC S AT 1 sl & s iO4T ENHLIX S, A5 )
ARES R R k.

3 Wit PictBridge BN, HTEWLE RBE B HIUEE “B3] pictBridge HUHSAHNL. #& ‘W
B OHARRRE. 7 .

4 Fiz [ 44HEN “PictBridge” S5,

5 [ 534 AL P A AT AN IR I AR R L ARk, JROR RS RIS o PR 58— I 5 1 4%
low 251

6 115 Z [ AR AR LI WA SRS TR AR FT ED

TR AFTEHLIEAEST ENILARARAE I, S SRS T HUANL, TSR E R, SRS PRI AL P b AT 4T
B

FTED
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i R TR AT ENFF A B H R A

1
2
3

BN A4 5L Letter ) (8 i 4R

ST ENHUERAF AR 1) <2 4241,

TAAFAE R BN A KB 35

UPRAF A L% TR I 5 SORS SCPRRTERIG SO, 0 S AT S AL % “ B, AR 44 (o 4%24HL

4 TSR CRERRTT” L AR EH on He L

10

11

12

S AT S AL LR PR T EVRE 7K T (R 167

T ARG LN B TET ERE 5K T«

o JAEfit A R AT I

o Jyiilif) 20 5K CERAF s P I T 21 20 5K)

o FZMHVE R CUERAAAE B IR R R AEAN R FOUHA 8D o W SRR 1 Ieaot, Tk 1Y,

% Al
FEGK TURF 3T B H K
IR I B4R PP EATEN IR . RESKIEOR I B, RBRZ0IR . FRiD . T BRI ARIR R .

TR AT, TR 8 A 1

2 TR B LI PRI IT I, G (o SR, ARTORE R IR IR TR T O A AR A

R WOR AR BOA IR R e b, W ROSE SR, HR R I

% Al

FTENHLIT A4 H R 5K T

BN AR, YOI ST FTEN R — g b CHCREAH S — I nT 4T, 3 2 BE R 4Rk — R i

Fo )

TR WA RO 5 AR K DU P B A ARaK R — 5L

% “Rtn/ BB HHCER OSUEA T,

MG PR R (TR, B R L R AT R 22258
% AT AT BN

R BRI R, W BN TR E A 24 U, SRR SE AT S T B ROR BT .

fiE/l DPOF \EUHEAHALAH T BN A
A8 MO FSCP T B Bk SU(DPOF)ZhAE, I ELF - D08 B AE M AL, IS PT L iz

WRLERE L RESKIET 3T EDJLIR AN AR T BN B o A RORE AP R A AT EIHLA s K AT D LI BAE ST BT 1 L
Jeis ATEIHLAT AR GR S

TR AR RO B AEBSARL b B, 2RI E T RS, TEBA R ST ENBLIA AR TK SO A
THEAE DPOF &2 RS .

1 REAMAIE, JRYOCIET BN — 1] B CACREAFEE— 1w 1B, 352 B BE R 409Kk s

2

Fo )

AT EVHLER AR TR b <2 $241.

TE
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3 AL
SR AR RMBEREE

& [T TR, R o .

5 [ A RHLL S “TEI DROF” | AR HRHTENRY
VERG: PUATEARE P A IE] DPOF SCIFI, BEHETI 42ty

VERR: BAELAEACR, WRTE TR S b 24 AN, S sE A TG T A, SRR

» N VA
T ¥ & P REATHTEN
o ULATEPHLAT UM W B0V 2.0 B SCRFLLU T B TAEBI: X RHEEBL(OPP) A H: AKX (SPP). 15 % if)
TSI WA HE R (FALECPDA) DU A T R e 2 R0 B M o U RS ) 28 e 4% A FH i
BT [
o 1 A1) Windows Mobile / Pocket PC PDA #1#] Ell Microsoft SCRY, #4875 BTSN 55 = J7 AR AE FI K 5
FEIF o WIESRICA ST d5 A RRENFE P I 245 8, ST PDA 13 B SCRY .

BB S HIT VLRI T e 2 22 (B O T %

VER: AT EIHUASSCRE T W2 e NS o ST LT EN ST

AR — O B SORAT BN, S8 7 BV B e MR BT EDHLZ TR 3 #E . I R BLRL 5L,

AT ST

o BREITEINLIR D ) BROA B

o WO T A AE G A

o SOAE P PR A e 2 T D BRUCHT B MP A B B RS 2 I R o TR S D A 0 2 B O U ] SRS RIS 2
Ko

o SN IR B AR E B R e SR P RS T .
M AN REN R I, ITHNLR S R AN EL R E T S ITEINLER N S W g R (k%
8 MBEH) o HITEINUGINEIZ T 8 MBI, St TR BT U AR Rl A SR h B o f s 2 0
BEEMIBRIGBER, ARG AR AT EDHLAGE ST BN

TR S O RE N SR T B LR T B A 8 o B

U EAT B LA 5 e 2 2 8] (A3 % -
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AR 1 Y 28 BE U —— 1 Internet D7) (I RIS E I 25 0] LU S Internet) o A TC LR 94 2% () 9 [l T
Re2s it A AR I B e, P ST b Bl 7 J P 808 J 5K v ] DAV o) S8 1 0 45

WEP

WEP (154655305 I AR i 95 o2k 22 4k WEP MK EE— R 7RSI, o8 WEP 2
E N
T4 W 2% TP 1) BT A U 25 R A Z5 A FH AR [R) 1) WEP 254, WEP 222 VEn] LA T Ad hoc M 4% Fl1 Infrastructure ¥
%,
) WEP 24N 1% h «

e 10 Mk 26 M NI AR HNEER TR A-F. a-ffM0-9.

B
® 54 13 /> ASCH F4F. ASCI PR 7R B b SRS Aa] DLAEBERL B4R 2 1 745

WPA / WPA2

WPA (Wi-Fi {3095 1]) Fl WPA2 (Wi-Fi f547 310 2) 7] LA AL L WEP B # [1 o2k I 2% 22 41 . WPA Al
WPA2 J& 2B 224k . WPA2 1§ T B 2R 77, Lt WPA Ti224y, WPA Fil WPA2 #iEH — R 745
(Fr Ky WPA TidL s s Pl S i 5 ) RARP TC LR 2%, 8k 8 52 R L BBV )
R WPA B E % 1%y«
o 64 N ANHERI AT T NHER FA RS A-F. a-ff10-9,
i
® 8-63 1 ASCIl F%F. ASCI FRu4E 7 RE. B b g mm e s FHe B 747 . WPA 41
ASCIl “FRFFREX 4 KN,
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TELk X 28 T (1) T AT k4 30 DA 254 FHAF A1 1) WPA 255 . WPA 224 E HBEFH T I AN S (B4R i 2s) Fiisg
£ WPA (1R[] Infrastructure (4% . K22 B ELESHT I 0 2 2% % £ i m] DLE R FH WPA2 2241k,

TR WAL ] WPA 5L WPA2 224, 4R I BRI W 26 I A T 0 22 A ME RN, 15 1%
P C“WPAANN”

ITEN R 4B i B R
25 5 A IO T I IOT ELIORC B, HEATEDALN IP LA MAC St
EIN 2L
2 AT EDHURARTTRL L N $5HL.
3 R ILH kL < PIERRE AR (o Bt
4 fi (o kL ge “ATEVRER” .
FTEWBLKF £ ATEN L3k 4 BB 1.

FETC LM 2% mH 23T BIHLAT T 1R B
B R TEIHLLASEIUICEAT B, f s B A -
o I ML, WRR SSID (s v B RS
o TR AT T I R S I Y 2% 2l 4
o eEY] (WEP s WPA/WPA2 #])
W E B R M 2 WEP 15l WPA/WPA2 4], I EAEIEA S Cogighdy) waEIFaEE ZatbE .
R N A WEP 2421k, WEP Z4N1% 0
* 10 ek 26 M NEEH TR, N AR A-Fo a-ffM0-9.
2
* 5/ 134> ASCIl #4F. ASCIl FAFdf v BE . HU7 . AR5 AT A7 B A, B4k 210 74
WS N U WPA 5L WPA2 224, WPA ZH N 1%
* 64 N NBEH AT TN AT UIEA-Fo a-f10-9.
2
* 8-63 1 ASCIl 7. ASCH Pl bl. Ayt drmifh o M) IERAL EERBIIN 745 . WPA B
ASCIl T4 E X 70 KN
AR IO I 8 A ] 2 it MISA S 245 Y]
HE: WREAME ST EAUITER M) SSID, FISAT VAL 4G FL 2% (1 02 B FH R 7 JF 2 4k b 4

ZRe IR TR BN 2% 1) SSID sl 5 5, 1S RBERE N SRR SR, B 5N R
SR N R

FETCER P 28 7 & 24T BT

P AE T 2 TP s e TEDBLZ AT, WA

o I T I EL 8 TR S0 FLT DLE R T

o GEBAROUEFPUE AR B A T LI LI .
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Windows F /
1 KA T IR A SRR
2 NI APLE .
WA bz Ja ol FHmR B I, T3ttt
a iy @, 3Rl TR, REsal ‘BT .
b F “JHHHER” o “ia17” HEP i\ D: \setup.exe, H A DJE%K) CD ok DVD K528 K54
Cc 1% Enter 5, i “HAgE” .
3 g g G b e R TEN L.

Macintosh (F3CHR) F P

1 AT I N AT

2 FTEMLIM G b T 2508 i 2 36 f2 7

3 BT Bl R, ARG R LS E e AT A .

FEHAR VR =247 Bl

FTENHLAETC R 2% 225 HR ), S P AT ] TSR LER ) LU e 2 0 i) SEATEDRL. (HJ2, b2 A
7 EEVT AT ENHLA T S L B 2R T BN LRSI Y o WNEE 2R IK ARy, 8 B AR — BT L s AT i B
i, BRI ST B T EIHL

Windows F /°
1 KA T IR A SRR
2 NI APLE .
WA reh 2z Ja ool FHnR A I, T3 ot
a iy @, Rl TR, Rl ‘BT .
b 7F “JHHHER” o “ia17” HEP4Hi N\ D: \setup.exe, HA D L% CD ok DVD K% 25K 54T
Cc 1% Enter 8, i “HAE” .
3 T EALEE R B BRSO U AL e DR E B FT B L.

Macintosh (F3CHR) F P

1 AT I N T

2 MFTEMLIM G b T 2508 1 2 e f2 7

3 BT Bl R, ARG R L S E e AT A .

Wi-Fi $57R kT B Ui B
WiFi ST I T B S AT DL R
o« REARUFHBLL
— FTERHLI S EL A T TP
— FTELEATHE S M AL T B BB R, R R AT R R DA

BES
62



o REROARLTREINZ
— TERLBAT i, ik &M & A H] .
— TEIHLEZACE T Ad hoc 4%, (HIEIUAE B AILARIK Ad hoe ¥4 REATIE IR
o BONIFLRL T EILZ —:
ITENHLE Y T2 AN fl Rkt tias) AIvE
ITEIHLIEAE 20l S Jo e N U EA TR, (ERE AR AT i G MY P R B ek IR A
C2eid Fe B T LR RN OGP T FLS T R AT T, JF HATEIHLIEAE 2210 P 4 7 Tl T
ITENHLAJC L 0 B AT REAS AT 2o
o SROFIRITENLERAE DML, JFHCaE& e, LU

TR TLE TR F

DL i 4 SIEH TS LA AT H o2k vi i box A 7 LR & —42% box 141 1-: LiveBox. AliceBox-
NOUF Box. FreeBox fll Club Internet.

TR IR R B Z A

o TR box BT IhbE, JFH T LIETCL M P E ] . RN E box DUEAEC Lk k45 h s 1 ) 3 %
HOME R, WS BRI box —i S S KU B SR .

o TEHHINER box HLIRCATIT, JF HAEMHH N CIT I FE AL L M4+ .

[ 45 I TE 2 P 4 A T B AL
1 BB A SR IR Tk I b e B R T DL
UHURERE PG, IR A
2 WHLIEI box SR — AN / VAL, i AR 4 2 R L
VERE: $ORHK / VERHEHLZ T, S5 5 MBI IR S AT EIHL I 2
< JEAEET I
MR TC L P2 I P PR P, AR5 Mol ke
BRI (R 2 M 0 B SR AE B e
a BN L4

Windows A/
B “RFVBEIMEE” .

Macintosh (ZEIChR) A/
MHIF ik $E Other Wireless Network, 445 .il; Continue.

RN PSP R AR Ay
ERE: BT box FIEHS. Bl box —HAEH# B SCRY s box (1M i3k 1T WEP. WPA 5
WPA2 4], MR Lt TR 2 a1 s8], s i s el i 9.
4 RIS R e AT R AT
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Eipchm ol | kel
TERZHI LML, fTEPLK < DHCP H 3 Bl — 1P bk,
1 B4 BCE, RVFTEHLA M Z i) DHCP Jilk 4545 #—~ DHCP i,
2 fTEN—IRMZE BB O, B YA FTEIHLA B 1P Motk
3 FTIFMIG Y, SRS EEAS A AT EDPLIY IP Hbhk. % Enter .
HE: WA TR, 5 AR E, DMEIERTT T EIHLIN L.
4 i “FE > TCP/IP > WEEHA IP Hullk” .
5 78 “Hhbk” TR N EAE IR E I 1P Hudik, SRR R .
WA, TG GO0 YA B R A TR NS P Mk, AR5 4% Enter .
MESFHPEZHER, ESERRGE AR

ZREWRT L RE

T AR ST ENHL e e & (B ic & ) 2 f 22 48D, TEARIR IR A R G R4
Windows F /°

1l @ 5 TR

2 i “BTRRERR” o “FBFF” , RIGMIIR P ESFT ENHLRE 7 SRk

3 fKUESE:
FTEINLER > WWRERIFTEINL > “RE” Wk > TRRENHER
4 RIS R TR S AT R A

Macintosh (Z3CHR) FF
1 M\ Finder HKIRIEF:
Applications > ZEFEIE FIFT EIHLSCAFR
2 Xt Wireless Setup Assistant.
3 LI EANL A EEE ST A

RRTLEE

Bz Ad hoc oM 2%

TR AL LU & F, B L3 — Ad hoc 4% .

o WAL i A M 2%

o WHTEME: (HEBHHHHENAA LMK IEH )

o FSUHAEFTEINLRNAT AT To 2 WX 4% 38 Be o5 1 T H AL 2 TR) 2228 — AN Pl V7 R X 2%
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EE:
o FEVETTURHEEAE 207, E RN I TCEE P 4 3 e 2% IE A O ReE B v R0 B, JOF HoaT BLIE S TAF
o IRAIHEREAT IR S (oM 4y ) eI 4. IXFP LS 2223585 Infrastructure /25,
o WRIETHHEMAT “ MyWI-Fi” 5% “ Wi-Fi Direct” , 14 0] DL B8R R I TC LT ENHL. 5S4
THEHLA S Bh SRR £ 4 L.

o FTEIHL— R BEAE— NG MG TPk T . 78 Ad hoc JE2k M 2% th fic & 4T ENHL AT LA S T ERHLAE HoAth 1)
T M 4% (Ad hoc B Infrastructure) 1 T4k,

Windows Vista 55 & i A
1 il “@ > EHIER > M Internet > MARIFEZEHL7
2 il “RREEEMNG > RRLL AN R GHENETHEND W% > T—37 .
3 AW E I Ad hoc M4 1R ST HAE . (Rt fEH:
a ISRV PIFT EPHLZ 8] R 1 255 1) gt — AN 4 44 Bk B8 SSID .
b X TNEMM AT, EMIASHEFHbIC S T AN, B KE 75,
C M AT RRAIRFIERE “WPA2 NN B “WEP” , ZRJE 01— WPA %45k WEP %4,
WPA 5 AN «

* 8-63 1 ASCIl 74f. ASCIl ‘FF B Sy Mn] DIAESEAE B4R B 747 . WPA B P
ASCIIl 745 7 Z X 7 KN

P
o 64 M NHEBITAE. NI A-FL a- TR0 -9,
WEP #4150 )
o 5L 13 4 ASCI 54 . ASCI FRHUARFRE . Heey AT BLf A EHRE0H0 744
#

* 10 P26 N ANEEH AT TN PR A-Fo a-fM0-9.
d il MR Mg EM. ETIAGHERIIC R T A, BRERS TR

Windows Vista #5243 %53 M Ad hoc 4%, Jf HAZasrE “IERBIME” e ] M &b, Roil 5
HlE 58k 1 Ad hoc P45 1L .

4 P Windows 7 il IR AT HEAR K 2 1
5 AN LR CEL, WE I S A LR SR T o g k.
TR WEALER M S S, B R AT S s X AL

6 M o kA, THRAE AR Mg XA 2 eE . MRS ETTEINL, DU ERE
Mt S .

7 R 2 AR 2 AR BAOREAE R A by, AR RAE T
ERE: Windows Vista tHEHLE R R 802 i, BT REF L E P &£ #:3] Ad hoc 4% .

Windows XP
1 35 “FFER > BHIER > A Internet &3 > MKZERE” .
2 figgrsh “RRMEERER” Kir.
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R BT, R E.
R WS T, WML E R C A T .

4 figipdy “REMAER” K.

i “EE > BERMGEI R .

R R “ToZ Mg I REA B, SRS 5 =7 AR R R A T R . b
AUE AT BB Ad hoc TEERIMZ% . TS B o =7 B I B SCRSSRIBCE 22 1945 B

6 %+ “F Windows RECER M TLLMBZRE " KILHE,
7 7E CEEEML” N, MR AT L.

TR, AR “MIBR” AR IR 4 .
Ly % Q14> Ad hoc (%%,

9 7t “Mi5544(SSID)” HEHH 4 NI A BRI JO L I 48 44 K

10

11
12
13
14
15

16
17
18
19

20

21

22

K M 8 2R, AT IO 2 B B A I ] BE 2 i B AR B TR A S HER TR T T
FaNN R PNCE ST

WERFIR P B “ MG KA, THERE “9TIF .
MBI SR “WEP”

AT AL, TEHOHIET “ Bah o EIRALIEY]” IEAE,
1 “E B HEF A WEP #4].

R M WEP 3 4], T R B E I ] fe el 2L B e B HER I IC sk T A
W, BRERE 7,

5 WA 17 HE A A [F] (1 WEP #].

wrh “EXE—AENBTHENL GRKD M2 BRI R I,

TR “BARE” RHITITINE H .

BTSN AT RER £ L0 PR PUIDET IO BEE . I R A R I P 25 FRIR S«

a fiiipddy “TTERMAER” K.

b il “BEATRHKLLRER” .
o WURMZECAH, EUR LA R, 1E1EFE Ad hoc W&, SRJ5 il “ER” .
o UWIRMSBATIHEL, &)L, RJEHRS “RIFTT .

AN LRPAICAE, NG LT SR B AT IO 205
TR WAZIER M S, B A5 R X AL

uf I g R RIS, RS I M s LRI 2 215 R TSI E TP, DUEERAE
ISP -

RS IR 28 A0 B 2 2o A5 R ARAFAE A3, AR RG]

Windows 2000

T2 [ B[] 85 PR A 2 I 2 3 B i aES S A3 10 35 B SCR SR XA 9GAE Windows 2000 HHC . Ad hoc 2% (1115
Ko
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Macintosh (ZFEXCHR)
1 2 Airport 1% & :
Mac OS X version 10.5 2 & & R A

M Apple S 5K L+ -
System Preferences > Network > AirPort

Mac OS X version 10.4 B,5E 2. R4
M Finder HK IR L FE
Applications > Internet Connect > AirPort

2 )\ Network Name ¥ Network 3 Hi3Z #. b #1. 5 Create Network.
3 1) Ad hoc WG — N2 FR, K5 i OK.
EE: BRI FRAE DR AE 2 AT, DAk kA .

I Ad hoc Jo&k M4 i3 i T ERAL
HE: PR N M R AT . F Ad hoc JoZk 2% R L B FT ALK 4T EVHLAA BT A7 At
Fic B ik 1 ek 4% (Ad hoc 5% Infrastructure) Hlfl k.
Windows H /-~
1 s @ TR .
2 i “PrRERERR 8RBT, SRR MBI R R EDPLRE S
3 MIILEFE:
FTEINLER > ERERHTEHL > “RE” E R > TREENHAER
4 FIRIH AR B S TR
H#E: Windows Vista 1 HLE B H 32 5, 0T Red 2 E Pk e s3] Ad hoc Mgt

Macintosh (Z3CHR) FF
1 M\ Finder HKIRIEF:
Applications > LR 1F] EIHLSCAFI
2 Xt Wireless Setup Assistant.
3 I EANLS A R ST A

i WPS L EFTENHLLAMELZ MM ((XFR T Windows)

i FHl Wi-Fi Protected Setup(WPS) n] LUZRFARIKG VHHLELFT EPHLES In BN I Jege i 2 b, RA e ml B H 3ok 5
Kyl 31 & SSID A1 WPA %4/,

1 IR R okt thds) SCfy WPS.
2 SN, AT SIS R R R SR AT A .
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EE:

o WUREEAEH WPS YUMBH 7 NI AFTEIL, R A SR DU, A BT B 8 (1L
e

o WIZATH WPS BCE T EIHLLMETCE A, (EHTCE S b BB B AL ISR WPS. T R Y 19 44
AN WPS [, MRS PR i g A SSID Al A PEfR K

7£ USB Mk [ #: (XFRT Windows)
AT AR P 18 10 75 2 U o5 I B T ENNLI i . DU R P BRI e 18 © e f2 e — PR e 2R T S T 18 I FT ED
WL, I HELETENLEZ22E THENRE RS . R SR E R @R T W ME, 1530 51 %R
FAY I 0 0 225
B T T
1 s @k “TFFER” .
2 i “PrAERER” ot ‘BB, G MIIRFIERFT BN SCaF k.
3 MKIRIEFE:
FTEINLER > EFEMITONL > “R’E” LK > ERRENHER
4 AN LR ST EAE.
EE: L E LT, N BT T B LRI T H ST ML USB HLSE .

P At (USB)E

1 M USB g il SIHLAIFT EIpL.

2 M4, S Windows $REI IR RIS 24T ENL
VERE: 1 AT LLARSE I T B AT B

£ USB MckiEZ 2 a## ((XfR T Macintosh e 3CiR)

AT DR 8 1) i %‘&E&EWI%‘“E’JTTEN‘}IE@?&E PUR AP SR AR E 18 4% I — M B 2R R . T 9T B
Bl WIRMEAERCE LA B S T e, T2 0 5 SR 5C Y o] AR 1

PR TRER

1 KPS I IR o

2 ST EHLIM ST BB i e e«

3 Xt Dell Extras > Dell Setup Assistant.

4 R RE AR S ECE ST EDHLLME S

HR: ELARCE LR, AT EWIFIERSTEINUR TSN USB M4k,
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Fe B A H(USB)EH:

1 K USB HE50)— BB e 4T EPLS I USB #51 . ¥ USB WL ¥ ) — o /a1 H ALK USB 42 1
I

2 SINFTEIHL:

Mac OS X version 10.5 5.5 & R Ak :
a M Apple K REFF
System Preferences > Print & Fax
b i+,
c ‘i Default £+ > EFERFTEIHL > Add.

Mac OS X version 10.4 E.5E 2R A :

a 7t Finder i I %15 Utilities.

b X7 Printer Setup Utility % Print Center.

C 1t Printer List X 1HHE H £ B FH AT EINL, AR5 ki Add.
d M Printer Browser A MFTEINL, 4R )5 i Add.

3 JiANTHIBN G B WR A B e i A L E BV AT EOHL, B LA

£ Windows 85 F L= — 54T EHIHL
1 & L B TERHLI o AL
a A FRESATIHERVHENL R CSCHERFTERHLIL S, AR e LT LU IR« 48
J&” e iE 2 Windows SCRYZRENAT OCE L “ SCAHFFFTERHLAL " BIdR .
b 7T EATIT DT e T EDLAR A
2 HRIRFTEIHL:
a {ESTEINABERTFEAL b, S CUR P BT R A -
1 5k @, sE g “FFeR” . RJGHd “B1T” .
2 7F “THRHER” 8L “iB17” HEPHiIN control printers.
3 % Enter 5, s Hl “HR” .
b AT EIHLE AR
c il “HE” 5 “ITENLEH” .
d 78 “IL” Em-Rhigde “HEXEITENL 58 “FEERT .
e HMIAN—DAETIAMFTENHL AR, R)G s “He” .
3 e AL e AT EIAL:
HE: WS IRERA HEEEAT BT AL
a LU D BT A
1 ik @, s d “IFeR” , RJEHd <817 .
2 7F “THRHER” 8 “iB17” HEPHIN control printers.
3 % Enter 5, s Hil “HR” .
b AT EIHLE AR
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c Hii “BH” B “TEVRH®” .
d il “S0 > %n¥w 0 > Local Port > Frug 1”7

B NARE €338 P i 2 AR HE(UNC) 1 3 144 7 @%E&R%ﬁa‘%f AR 69 DU 2D IR 2 R E AT EIHL
FRRe S AR IZ A LU R \\IRSF 23 \{TEIHL.

i “HE” .

FE “ATEIHLER 107 REAE A il “3REA” .

TERRINAE “3m 107 IR Fpak R OB I 1, ARJE el AT .
i “HE” .

(1]

- T Q =

£ Macintosh (ZE3CHR) 35T FLZITEINL

1 7t Finder £ 1fi - #.f; Help > Mac Help.

2 7F Search 7-BtH#i N\ sharing the printer on a network, #RJ51% return .
3 LA aesiih Lk $ —27:

e 5 Mac OS X FH P 3L B ITETNL — o il Mg b oAb 1] Mac OS X version 10.4 5 5 &5 il A4S (1)
Macintosh 1AL & RAE 1K) Macintosh 1581 LT EIRL.

e 5 Windows P SL =BT EIHL — A VFRIZ% 1) Windows 5148 3% 8248 %45 (1) Macintosh -5
ML LT EIHL.

4 RIS R TR AT R A

HERE: Windows H 7 ] LLZ: [ Windows 5 Bl SCRYIRICAE S7 I 2541 ENFL %42 1) Macintosh 1AL E
o

Y 28¢5 W, ) 25

14 7 Wi-Fi Protected Setup?

Wi-Fi Protected Setup(WPS) it — i i .22 4 ML EE, i LLA s e JELk 5 W s PR T g 2 A, R
TR T AT WisFi BRI, R 15 2 0 4 U 4 L T P9 44 44 7 (SSID) AT WEP 5, WPA 21,

HR: WPS HChRlid B N i (T i ad) BEAT I v b 45 .

FTEIHLSCRE LU R TR IE L B o e M 45 «
o A RBFAPIN) — K537 EIHL B A DU S 5 A BN i e BEE
o JZHIAE(PBC) — FE4RE 1 BUN IH] N 20 % AT ENHLAR A R B 2L

BN PIRRIC iT B B R e 5 A WPS:

*, WiFi PROTECTED

" Y/ SETUP

o

WA FRETECTED

BT AFERS N U 5 T8 S T 4k 213X 28 WPS f#ihse.
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UPESRICE 2 A7 SRS 2 B B AN E RN s ) WPS SR TERIE R, S BRI il fe i
SR, BE LRGSR N R

8 B AT AR B TR WEP 45k WPA 5457
o SEMRGSIAFIER.
— S RS ) IR (A7 A WEP #5150 WPA #55).
= IR LG Intemet ST JOTAISP) 46, 1650 LLAMR NS S et i
o SEIBRENEA S Rl —REEI B,
S B A SR PRV BR A B, 65 T BAZE D SRR BRI I £
o M AT AR,
1 FTIT R TTRIE %, AR ZEH RS P A BE A S 1P ML

EE:
— WESRBEEN R IP il TS BRI S 2R O B SR, s SRR R ST SR
3

— WRGEAE T ARG A, TR A ARG A, DMEIERITIT R L.
2 YRR, TR R A .

ERE: WEP 4]k WPA %4 52 N SIS AR o S50 a] LA VRS U MR S B . WEP %4
B WPA 24 0] LA A VET BV T SEH LI B R IR Z M 2% v
3 &4k WEP #4]5 WPA %54,

4R SSID?

R 1% B R (SSID) A F TR A JCER I 4 i — N 44 FR o 48 TP K T 12 o AU TG 2 245 1) SSID, 15
MGG HAHIE R H, TELMZ) HIH SSID LLAVFX IR P I e B & BRI 4% . T 2242 5K,
A AL 4k SSID.

SSID % 1] M 47 32 M FRESECE T4

W EL AT LA 23 A) SSID?
* MHEMAR CLE&H M) ME.
RN RUIAT B R Z I 55 2, 7l LU P A 28300 B g il
o R A RTINSO SR T L M SE IR 208 T AN AR o
R MG RGOt TN TR, TRV ER BRI L LBs, BfE%H SSID.
W ARAF AR S TVEAN e R BIE 1) SSID, 1 S8 RZ SR AN ABER .

Ha R

W 2% e 4 2 I L BB 2O B AT I AR B, Bl SHL. STEIRL. DURMISRLRAS . A A
HEs . — AW LURBATER I JER I B RIS e ek i
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WA PR BB B 28 BT A R 2 2R B ?
o SRS R,
S I I 10 N (A7 A I TG 8
o BRBERGHRIBA S CRgBi s — RIS,
o HrEEIE TV 1 IR I IO T 71
RGBT S, R TR

TR -ac oo it
10 M8k 26 A N3 745 | WEP
i
5 A8k 13 > ASCIl 74
64 AN EEH TR WPA 1, WPA2
i
8-63 /™ ASCII F%%

EE:

— NSRS A-F. a-fF10 - 9.

— ASCI AR s RE B fny IR SR BB 7247
o NS LEEREERE,

1 FTIFM TN 8%, SRS 7 RS th i N3 A 500 P Hihik .

EE:
— WESRBEEN R 1P il SRR SRR G B SR, s SR R ST SCRE N Bk
3

— WORTEAE TACEE AR 55 4%, TR I AR AR 5 A8, DM IERRFT T M 3L,
2 BRI, AR R A .

HRE: WEP %98k WPA B N B i ANl . 8565 T DL A VRIS UG IR A R B . WEP % 4]
o WPA ZH AT LA SR VFT ENHLAI T SEAL I SIS ) JE 4 25 7
3 Ak WEP & H]al WPA %4,

K PR AT BC . ?

B I AHUIRAST EDHL SR R 2 p AT I, AT AR AN/ Py B e 2 ke o 2k M 2%
T8 A o

R LM 22 A R R E 22 m 4 o LT R DY AR Y.

FER: T BT EIHURR WA T A ST EIR 55 a8 EFT ENHL, W) LAAE R 26 Fp kAT il i

To Lk M 283t

FE1: MEPRINAEFERNTLLES, 7] LEES] Internet
o T ETFEAURFT ENHLAS I H A LK AT 2k DO RE ) 2% HH 28 R AE N 45 H o
o UL ETHURNFT BN I o B AE B i Ay b, HAR TS AURFT BN L A 2 .
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o 4% id ik DSL B HL 25 thilfd R 28R 2 Internet.,

o5

J

HE2: BEMLE, 7] LEEZ] Internet
o T TFEAURFT ENHLAR I TC Ze e N\ T BTG 2k % HH 28 IR AE M 45
o JoZRAE N Sk DSL B LA A E 28R Y 25 E 2 3 Internet.,

R NN RRN RE R ll!}))))]])]))))]@

J

I-:'I LLC L Re e EEEE LR E e EEELi

Illltfffffffflllllﬁ

FkE3: LM%, AALLERZ Internet
o UFEHLAFT ENHLME I TC 2R N BB RAE L
o WL ANREERLF] Internet.
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i Il:lI CEERCERTLER LT EERERTEEERTELTd ] liﬂl@ﬁl}ﬁ:l.l.!-'l:l.l}'l:l.l}'lfl.l}'l:l.l}'l:l.l)'l:l.l ERELA)

&
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7 4: THENEE T EEBFTEINL, AR LLEEZ] Internet
o TMENLEEIERBFTEINL, WAl L A% .

o XFhCE JTVERRAE Ad hoc W45,

o WL AREIEHR Internet.,

/ :
-!l.(il:l:l:a'.l.hl:-:l:l:IZ-!*.(&I:I:(-!L(il:-:l:tl.hl:-:l:l:l:-!l. EREERRE N R R JJJJJJ?&J?&J)&JJ&JJ@
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e 95 U1 “YFTEIIS VIS L AR e

TTENTUAZ AL ATV R BAEH =
AR MR BT VROV R, 555 R o i

KA/ MTEIRE
BrAESEATH JEa St ohe, 5 WHE AR LT i dse N T ER L BR v
o JEilBEAAT TG
— 6.35Letter )] 4tik: 6.35 =K (0.25 9&+))
— 3.37 [ Letter IAMP I HAhatik: 3.37 =2k (0.133 %))
o L. 1.7 =K (0.067 7:))
o [ilfh: 12.7 =K (0.5 %))

BRI AT N T he

Windows f /

1 FITF ORI R, AR AR b sy “ 30t > $TER

R TN b SN A S

3 1F “HTENRE” KRR “4RikiEmT” Rkt “TBlR” .

Macintosh (ZEICHR) H

1 $TIF A, R P b it File > Page Setup.
Wi File S 547 Page Setup Wil H , THEEZRIDH 2. & NE R EEBHFTENBIE :
a J\ Settings i 3z 1% Page Attributes.
b J\ Format for 5t i = i £ 5 14T BN L

Cc M Paper Size i IEF LR A “(Borderless)” 4K T
filn, WEREEENT 4x6 vk, iHiLHE US 4 x 6 in (Borderless).

d EEFTEN T, AR5 AT OK.
2 Mg ¥t File > Print.

RSO AP A HRE THTEIRL. ARKSOIAETED 1R, 7R RIDER 3 20, #ErIfebZi Printer
i HH SR AL PR HDFT R PSR AOAT BN L. 15 IS B X L N 75

a M Printer i H S Lk RIS ST EIAL

b I\ Paper Size gt bk FE AR A AT “ (Borderless)” 4K ).
B, WERERENT 4x6 vk, iHiL+HE US 4 x 6 in (Borderless).

Cc EFEFTEN I,

) g 25
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3 wHVE, ¥ Advanced.

4 JFTEEI S A P R Print Settings &% Quality & Media.
e A\ Paper Type it % s PR T
e A Print Quality 3 Hi 32 §. - 1% $f Photo 5 Best.

5 ik Print.

T ENA BB P HH B4R BU RSk 55
P PSR B2 T R SAT AR, WA R IR s

BHEBKE
S R T E

FEAT ENHLER A P IR R AT N B
TERAT BV S R IR
FIEAT Bk

TR VL BR BER LT B ke K
VERK: WSS A SRR E BRSO, TR S

5

ITENH 18
U PSRRI T R AT AR, WA R IR R s
R E B

o TERMIITA AN IFER .
o JER YN SR R R MTENR R ACR AR
o REMNERGH LA K,

B AF
SR T STHUG 2 1Y 77 (RAM)

FEIT DL I BB R AT B &
F IR RIS I ARTR KA
I 223 BT AT ENHLER A

) LA 25
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AT EIR TR LR AR NS
DL R AT REIAR T o TR

MAREAEH USB R, H=_E# 5 —MR USB B2

WREAEMEZ T, FEFBIRAL BFHEE) KRR
1 AEAS LI,
2 10 BB, AR TR UL

K EVRI 33 4 7] AR

* 5595 U “IT ENHLAN G S BN B il B AT S .
* 5595 B “HMIGH AT R
* 5595 U “ A BB R AR
* 5596 U “ICRERM R B T a7
e %96 U “HIHiA T
* 5596 U “HHMIE ST AL AR K I o) i ¢ BOEL”
* 97 T “Gikilnd & ALY

ITERHLAS RS B B3 8 B A R B
P PSR B2 T R SAT AR, WA R IR s
RGBT AL B N BRIN T EIAL

I 223 BT AT ENHLER A

CEEE NG s Z S PN

1 SRR

2 WL FTAT S BRI TR e
3 KL

SHIEHEER REIEE E
B AR ) B BT T A R, SR LR — R 2 Ry v

3 LY G R
FEAT ERHLER A P R B 1 R

) g 5
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W YA R B BRI 3RS AR s T R &
A5t FH 5 7 b 900 SRS B P B DR A
TEHIASCEEUR F B MRS L, FEAM T IR AR

SO B A R R BB T — 3R>
R AR L2 T R I R R, 55 B F R — B B 7

TERIASCEEUR F BB RS L, FFEATIERR A%
FEIT EDHLBR A i B R AN B4R R T
WA “RAERS” B EBEEFRMK IO R —2

HA TS
G “AEIR M) B BT RSB Y] @, 15 2R LN B e R
g USB %3

1 Kot USB HZi A W R AR . WERASEHUA 1, B —HUBTHY .
2 %5 USB 145 BB B g 24 [ M el A\ T ENALS TR USB $1H

3 K USB 45 b > 10— 2 [ i dd Ao EALE USB #2105
USB #: 115510 kRiC A USB 5 e<5e.
FERE: R R BALREAE Y, GRS A USB 10 . S n] REdE e — N s i3 0 b

BT a v E AL

FHRAESTTEFR K A I (7] 5E S BUEHL
B AR B2 T PR IRAT AR B, A R IR

R A EARANH R A
BRI R

I LR
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p/nr U E BE RN )
UL AR AR 2 B VR I R R, R B F R — R B 7 i

VERIAST EDBLAN B 0 S e R — A o
VEBRIALE F MR EEHL b 22 T 4T EnpL R pf

TR SR &

® EQ7 U “AEfifR IR AR R I
* 97 BT “HBANALE R JE BT AT SN
* 5598 U “Ioih MAF R BN A7 IR S A h REAT HT BN
* 5598 Ui “ AL T M 2% NAF AR ALIE I A7

FEHEF IR B B E R

AR YRR BLZ BT, B OV R LA Yk M R
o T IO i FAT BB R

o WA R R SR

o AR o A SRRSO

TANIE I SR AT
I AP R B R ARV, R R IR R e

ERTRAE
AERRITAERI KNS, LB T T AP

g USB %3
1 K& USB 25 &5 H H A, WG HIA T, EMH—MH.
2 ¥ USB 25 47 19— A= [ B AN FTERHLSTE B USB #: 0+

3 K USB L4 F P — i 2 [ M il AT SEHLA) USB 45 1
USB #2155 brid AT USB £ S e<5e.

R WURRERBCA R, SRS AR USB 1. T REIE AR — M R AR B

o 7 Y 2% JE 7

DR FTENHURIH SN AR IR AE R 28, IS WA A AU & R AR T TEAE TNl B BT L £E
FTEIHL e PEvt- 5L

) g 5
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Toih WAF iR BN AP 3R B 4 P BEAT 4T B
I AP AR B R AT RO, R R IR R

K& USB %
1 KA USB G S A W R BIR . Wi BIR 7, W H — .
2 %5 USB HLZE _FA 7 (1 i 2 [ Ml AFT ENALG i1 USB 5 1H,
3 K USB Hidi b i~ 10— 7 [ Mg AT SREHLE USB 42t
USB $: 1 55 ibrid 1T USB 5o,
HE: W BRI R, WS U A USB 42 1. S8 m] Rede e/t — /M s g4 1 b

o 7 Y 2% JE 7

DR FTENHURIH SN AR IR AE R 28, SEWR AR A AU & IR AR ] TEAE TNl EIEBT L £E
ITEIHL e BEvt- 5L

p et ALY S v e
I AP R B R AR, R R IR R e

TERAIT BN B R AL IR ER BT, R HAE S e
MATEIHL_ LR3I P i # IR v LA

TETHINE I To S M 2% DR IF Bn] DUEH
WA I T AR R T, 1T USB MU Bt T EDBLR AL

To2k 7 A fiE &

* 5599 BT “ILL iR A E E I
* 5599 U “CREICEBUE MR M) ERIN IR
* 95100 7T “ oA oLk Mg AT AT RN
® 103 5 “ UL HH JCIAER]
* 55104 7T “TCIEFTENIF HAF SRl B 22 7B kdk”
* 9104 UL “Wi-Fi e =i Ase”
* 55104 51 “Wi-Fi fien k2 2kt i, (H23TEHLATE (R T Windows) 7
* %5106 5T “Wi-Fi fa/s AT 2t i ”
* 5107 7 “AEZ B RET, WI-Fi fit AT N SRR (1
o 111 U R LARTCRATHIR S5 4% 7
o S T AT ILAT BN I VR fE R
o BE112 5T “HEH B A N M2 (VPN 55 T ERFILI 38 71 0 1
® G113 T “fif Pla] EioC L i i)

) g 25
98



TCER 1] R AR B B ST

TETFURTCERFT ENHLIN In) SRS /T, WAL S S 00

o FTEINL. THENURIJCE N i #HaE iYs, I HrIR CFT T,

o TR M4 nT LLUER TAE.
AR U ) S5 1) JC 2 N 4% HP ) A TSR L
DR F M 28 1] LT ) Internet, 115221800 i 1 2k% 9% 3 Internet.

o {11 SSID J& IEHI .
FIER— ok P 2% B & DR B 4T ERHLIT A A () SSID.
WA 2 4510 SSID &R IEM, BT T L&k E .

o 1K1 WEP %4k WPA 4 1E IEHI (WIS 451 22 1) .
BRI S LRI HES) IR A2 E .
ﬁi%g%@?%@oﬁ*ﬁ%%@%¢%%ﬁ&%(ﬁ%%ERVWA&WWQ)%%%%*ﬁW@%
YA
WA I 5 S IEM, 6 Rl T L& E .

o FTEIHLAITHSTHUAT T IC LR M 4435 il 1A o
Efﬁ%ﬁ@%*%,ﬂﬁﬂﬂﬁﬁﬂ@ﬁﬁ?ﬁﬁ%%%Aﬁ(%%%m%)mo%ﬁﬂm*)HW%
7o

o Wi-Fi #8741 525 IF Hogartarm.

o ERSEAT AT ERHLI VS b 222 74T ETALEK SN R o

o RS T IEMAT NG

o THEHUNFT ERHLERAE A — A Mg .

o FTEIHLZE & ] Ae TR0 L5 5 M BE A A B HL 15 % o
WA ST ERALANTE Ze e N il 2 RV A 5 4 DR R T AT A L B RE BN S AT
IRZ WA LT IR S, WiFEJLIIAS . KWl L&, 2 RGEMAHNL. AR IR M 45 Fl

IR

AL EERZ AL BRNEE
1 ST EDHURAFTIAR LAY X, $241L
2 RELE SRR “FGRR IR I (o e
3 JRLH ALY A PGHETTARN h T BRIME” L AR (o 4L
8 [STHA AL “R7 . A (o 1L
FT B BB AT ) BRI B LT B 3K 4 B B ST T A

) g 25
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TR IBIL To Lk M AR AT T B

SRS 2 B R T L (S HOAT DL AT BRSO, SR AT N ST E L
AT BLAEAT EDBLIR I, 65 T LA 2 2 M T 2B 1o

(LS TR R LT, LR I AR RO, AR5 S5 0R Bk R I Ty ik

RKEAFHEFITITERAR CCLEE )
S A SR, AT ENHUAT VST TERTRR S b . MR T LRI 940 8 BT A e i .

MU AP 2%(VPN) 7 T332

M VPN R A AR 2 i, R A REAERS I M 2 R A ST EIHL. TE A A VPN, SR H08r
FARITEHL

WA “ERER B

2 CPORBEN R, T ETHLI A TR
FEAT EDLRAR TR L 1K

o> BREER > 3% > (R

AR K WEP 50 WPA %4
RSB AU WEP 5e40bE, WEP 5910400
o 10 26 M PNHEIFAT, TG A -FL a-1H0-9,
2
* 5ok 134 ASCI 5. ASCII FAFUFETRE. HUTAIM LL{ERERE 4RAIN 71 . WEP %911 ASCII
FRRER KA.
RSB ST WPA 50 WPAR 540, WPA BHI 200
o 64 [ NHEHIT AT, [N TR AT A-FL a- 109,

o
o 8-63 /1 ASCII ¥, ASCII FHHIHRFRE. KA LIZEHAL EARFIITAE . WPA 53l ASCII 5
BREX SR,

EE: WREAIERER, WS MR B3R AR Bk, B 5 2 o 4k 44 1N D1 Bk
3

REEREAN R LRER R / HEMEE

FERRIN S PR AR, S 1 BT e 25 TR s T EDBLIR,  To&k wiair box (i LiveBox. AliceBox.
NOUF Box. FreeBox % Club Internet) nJfg<s BRI SBE / 1 WHE 4

USRS I box HFR BB LM 8, 12 MBI box U HLIMBYCRT, 80 5110 Internet
55 B (1SP)BE R -
BENER LR BN R, 2 aBHAhE i
B TR BRSO B, B LM S RGHINL) TR I TR
ST DA A B LA B B e 6 (A )

R
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Revh EAUR / BT EIHLS 3) B BE B N\ R EL RO 3t Ty

BRI ML RGO TR Z R, WA RHRA RO 4G B AR RE ) o AR IEAEST BN 2 ), 1
AR RETH SEPURSTENHLI AL S, A (T2 e (8 AN 100 9e .

RELLFESRE
FTEN IS B IO FR B (5 5 . BRI O 3 R st I, 00T 3 S0 ) BRG  SLAR B 2

REEN AR RERE
o WUERGEEAEH MAC CBEVRDT Il 750D Hubikid 8 T ek BRI A A 8 1 JC 2 RZ (DT 1), Sl 250K T BN
HLI MAC Sl 73 In 2 af DOERE B Uit s 38
o WURMREERE RN SO BRACE 1) 1P Mk, A5 SUR I, AR A R g T EIL
R WREA T ATHTIZ AR, TEZS R R RS B SOk, o 5 2R T L 2%
PN

WHIANERTHENERAERRERA R L
o FTTFASH I TUI YL B U AEREI S, i B R AT AV ) Internet.
o WnSRASH LI AT LA SERLSR U, PR E B A 7 T LU VSR LA

VTSIV LR TR B A — A T4 s

UERATENHUAITE SEHUANAE [ — NIk M 28, B AN REEI T AT B R SNl DA R T2 M 45
ITEIHLIY SSID 2545 5L SSID — .

Windows F /

1 SREGT LIS M 4 1) SSID.
a  LERSIR I B B R R E A A NS IR N S 1P Stk

WA FIE N ST 1P Rk

1 ik @, 8 pd “IFeR” . REHd “B177 .

2 18 “THRHR” B “is17” HETPHIA emd,

3 % Enter £, sl “HE” .

4 i\ ipconfig, RJ51% Enter #., &F “TLEMLIERE" X .
* Default Gateway (ERIAMISC) i H il i RIGFEA £
o P Huhkth 4 HECF A0k, AR IF, Bl 192.168.2.134.

b MHISIRES, AN S AR,
c il “WE” .

d 7 “k&E” X &k SSID.

e idx I~ SSID.

EE: EEAGHERC R T RN, O8RS R
2 REUTEIHLPTEE LK M 2% (Y] SSID:
a MITEIHLITED 5K 2% BB L.
b 7 “Jogk” XAk ss1D.

Ir) LA
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3 LRI EAHLAETEIHL SSID.
U SSID HIF], BLWITHEHLRIT EDLERAE R AN eZe M 48
W12k SSID A, E BT Ie T L BEE N AR, AE VAL A I Jo 2k 9 2% i 22284 T B

{¥F AirPort ZLu5 %) Macintosh (ZEXChR) FH A

Mac OS X version 10.5 3¢5 &5 [ ERAS
1 M Apple S5 R IRIEFE:
System Preferences > Network > AirPort
VIS ER I M 25 11) SSID ¥4 .7 7E Network Name 2L,

2 idxt [ SSID.

Mac OS X version 10.4

1 J\ Finder FP4& /0% £
Applications > Internet Connect > AirPort
THE ML &M 45 (1) SSID Hf2x 7~ 7E Network S,

2 i3t [ SSID.

{5 ¥ S ) Macintosh (ZESChRD) F
1 ARSI Y G0 2% B A R AN S 1P Mk, SRS ARERiIAT DU 2,
WHRIEAFIE RN S B P Mk, 35 3% B8 DA R B0 R4 T 0 1 «
a M Apple & HAR IRIEFE -
System Preferences > Network > AirPort
b i Advanced o} Configure.

c i TCP/IP.
Router C#fH14%) I H % RN A AL

2 YIRS, RGO 2R, SRS Hd OK.
3 “LLwE” Kb Ak SSID.
4 g F SSID. AR WEP #4] / WPA #H] (IRLERINIE)
FE:
o THMINIEAES I Id SR T MR, BIEREFEE.
* }% SSID Fl WEP %41 / WPA B RAFAE 2 A 7, Ak RAE

EHIA B RIRAE RS S T ARPoRrT ITEERFTEN (fXPRT MacINTosH T3
79

FIERHL I SZF57E Mac OS X version 10.5 5 & hicA (Ge3Chi) Hidid AirPort b 8E47 kT Bl .

) LA
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“oker” AR EH
HEIUT SR FIORRTTE, BB “AREE” FeHIZE m IO ELT B il

K fr USB H 45 2 75 22 [ s B e v VLA T ENFLAY USB #: 0 1k
USB £ M350k 0 17 O™ 155

EFAITEINIEE R, JFHBRFEEITIT

Rty O S SRR RS . R RIRIT TFATEDNL, T e 5 227 TP L prde % USB .

A ENL_ LK USB O my LM
SR FO A B4 TR USB 2 1o 0 LA o LA 32 1 b e A P SCA A B 082 0 T LS
IS LR USB $2 FURREREFE, 2254t F o BB L FoAib iy USB #2010,

HHHIA USB HL 45 A] LUMEH
ARG USB s, f SR 0 AR KSR T 10 BER, 3% WA B P 2.

WHHIANEEH R EH TRRITENE S M IEf Dt
PLBOAE 4T ENBLAL S RIT EDBL RO 5 o M7 Ri% e MR8 18 TR 251,

UWERIEATARMTSE ], T AFRATHI MG LN BEOT A (3T EDPLERA . WESRBCEZ M5 &, i8S T
R LT BRI s AT DU A T2 e SR H A B R WA T

BB AR
1 KT LI R
2 WL LT AL
3 WATELIJR T FUERLes, 05 T .
A LR TR LT L
5 THTIFTENLRA, AR IR T SEBL L kit

FIREFIBAT R
1 KRR
2 WD SR EHE S SL
3 WA, AR EHHET R
FERE:
o HEHENE] “ DI RN, WA T “SEITEAL

o UURHEAS] “REBHHITEING? 7 FUfint, WURE T2 THIITEINL, EES “ HibritE
HL” Bk ik 22 ) S,

) L g 25
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REZRTTEIZG% IR USB #10 L USB 1&3)

FIT A TS, K2 USB #:10 FifER: 7 USB WA I 4 B 28 L A BhAE

1 @, sliEnd “FFeR” . R “iBIT” .

2 F “TFRHER” B “E17” #EH %I\ devmgmt .msc.

3 % Enter #, m& i “Hhe” .
WA IS .

4 75 USB 421 Fi%$; USB W g s Hofth (¥ 4%, [N LB 48 A7 BB 70 1. Y4 4 A BB Y USB %
BRI, B RS .
o IR PISAIE, HRE DL ETVEEASGERR i) B, R R BOR SR L .
o IRV TIIEE BIE, TSIV NS [ USB SCHEG 10 8. W4T 2238, L

ety iR USB 4%

AT EIF HE RN L2351 B kI

$=J5 (4F Microsoft) [\B7 K&l RELx TIALATEN . W RAT ENHURITH SN LAR L & 1R 4, JF HIACZ 25T A
IEH AR, ERATENIIAREREAT IO EATEY, FIRE R KB e A RSN b 2eke 115k B% (B Windows
Bl KA LAAR) U L Al el b5k

o A 3 TR B AL BB AR T G R T s KR o 35 2 B L ) 45 P 95 K s RS BRI 3 B SCRS T A ] 54
o AT EIHLECE ZRIT BN, SR 1) B KR SR VT IR), A VIR e AT .

o I EE B K, ARG AEVH ML B2 R dTEIRL. Mg e 2 Ja,  F0Bra B K.

Wi-Fi $E8 T AR
K2 B YR

W Wi-Fi SoRAT AT, 3N O FRRTsed . Wil O SRS, IR A LR A
o THHIATEIHLRGE I, JF HARESTIT

o TEAIAST EDHLIE AR A R A4 AR L

o WURITEIHLIE LA IR AR b, IS HIAIRZAR CATIT, JIF HaT BLER TAE.

Wi-Fi f875 4T Rk tH, HEITENATE ((XRT Windows)

RIS C A5 T ICEAT BN, JF HPTAT s B A IER 1, (EETEIHUASTED, 3§ 2 BU R [ —Fhel 2 fl
Jiik:

FR LR
WRESRATED, B Ot SR IT b, HAUEAE LA JH.

) g 25
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J& FFTEIL
WHAITEIPLE B H
1 A @, S Rd “FFR7 , REnd BT .
2 7F TR R 8 “iB17” HEPHiIN control printers.
3 fZ Enter #, =¥l “HAR” .
FTEIHLSCA IR e i
4 LR EINLIEIRR, AR SE s iy < AR BRALATEIAL” o
5 KM “HTEDHL” 5L “TENHLAMEIL” &1, SRIGHFaldT .

PEFETCLATENHL
REPT RE T SEAE R BTSN LR R ST EILA T LGS AE I HT ER AL
1 A @, S Rd “FFER7 , REnd BT .
2 7F TR 8 “iB17” HEHHIN control printers.
3 fZ Enter #, =¥ Hd “HR” S
FTEIHLSCAE IR o i
4 LA UL ARG, JF G «© (M8 7 FRERSTEIHLE bR
5 Mapthsg s iy “fE FHBRPLITEINL” -
6 KM “HTENHL” B “TENHLAMEIL” 0, SRJGE T al4T L.

ks /s A
T A DA 4% FEA B2 (14T B L2288 1 IS OHT ENHL,  RnT Be 5 Bk I 44T ENALA RT LGS AT HIFTERHL
1 A @, S Rd “FFR7 , REHd BT .
2 7F TR R 8 “iB17” HEP I control printers.
3 fZ Enter #, =¥ Hd “HAR” S
FTEIHLSCAE IR e i
4 L AT EDpLIEIbR, MBS g
5 il “¥gH” I,
6 HRFHATH I o ST H AT ARl
7

U SR T R IR X R e A USB i L, 1 ABIR TR R CHR 7 XU T EI L
F7 s e Gk “ATEIHL” DX 3T ENHLAL S, BIA TGO T IERA 3T BV D LS 1

8 il “WaxE” . W HH T EL

) g 25
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Wi-Fi $5754T 21

1 Wi-Fi 3878 KT W RE IS, T RER ST EIAL:

o AT LE Infrastructure B N HE/ T B

o IEAESEA S I o Z v ek ST Ad hoe 1

o BATHERA IO S M 2%

FIEIHLAT BB T BE BE B o gk e N i Rkt 28 ) NG MV A M4, 5038 T E U T Bl & .
AT & W] eI T v o 1S e () — Pl 2 Fho7 k-

T2 199 2% 44 B

TR 1 199 258 AT 1 AT A PRI P A P 28 AR TR PRI A2 B o 9, SRR PR 08 Jos 8 T A3 7o BR A 1 1Y
AR, BENFTEIHLAT RE S IE R R A AR S R P 25

UERIEBAT TEHIME— I8 20K, TS PRSI AR R R has ) AOFEBY SRS T et o] e 8 M 2% 44
Mo

WERTEBEE T WM A FK, B ZUR AT ENHLAITH S SSID HBr B &N [R— A 2% 4 F

fEZeEwmY

MR EAEH WEP 22414
AR WEP B9V 1% 4 -
* 10 Pe 26 DN H 74T TN PR A-Fo a-fM0-9.

27
* 54 13 ASCIl 74F. ASCIl FHHUTE 7 RE. Ky Mrn DL B b 4R 3 1 745
IR WPA 2241

AR WPA 2N A «

* 8-63 > ASCIl 74f. WPA FH] () ASCH 74 EIX 73 KN
2

o 64 N HoNBEH AT AN T UEA-F a-f10-9.

WERIE I TCL B B T i ft, WA ST 2. BATAHER A HIZ R I 2, Doyl
PASOVR AR 5 AR e 205 ARV T Ao 85 ) 0 245 B 5L

RSN / SETEINB S BIBEE EZEA 1 ek hias) HWEIT Ty

802.11b 1k 802.11g I 45 H (1) ¥ 2% 2[RI R EE 2 m] LIS 21 300 e/, 1M 802.11n 19 44 1) o 4 94 £ i [ ] fig <
g IR Z ML R HGR TARZ 3, ARG R0 Eh 25 R P 45 IE PC AR I RE T o A SR AEAEF T B I 3] i)
A, AR EE T S NS EPLIGAL &, A e A2 (8 (0 BE 2 AN 100 S8R,

1T LAAE R0 28 a0 D e 1 2% 45 5 5

K2 MAC #Huhl:

WS R T MAC sl g Th e, HHVKETEIPLEY MAC Hulik s n ] MAC Hulikd ygg &, w]
CASSVFFT EVHLAE P9 28 A

) g 5
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fER RS, Wi-Fi 38R 4T N

4 Wi-Fi fFopdT IARRE (T, FORHT EDBLE Tk B L, (R TR L SRR FLT EDBLIR IS . ATEDBL ]
ARl T4t BB AR A LR 1178) KB TR 4, S0k i S TENHL L .

LRI IR i

AR R YR 2T IT

TR ERA R, WA RE, TR .

BENEHIEA R, PMETIE/D

Fofb B g% (BIUnflep s AR B TEdofiihi . 2L 2 e RGN rTse S Bl 9. 9
BN R TBCE AL PR B X SE B AR AT g T

Revh AU / BT EIHLS ) B BR B N\ R EL RO 3t Ty

802.11b 5 802.11g W £ H (1)1 £ 2 (R I EE B i) LUIA 2 300 9 )], 1M 802.11n W24 1) Jo £k M 4 Y [l vl g 2>
e o S TCZ M2 FTE IR TR 2 R 3, AHEIE I N S C 2R I 4G HE A8 IR ) o A RIS AEFT BN
)8, T A N T EDHLAO AL, e AT 2 A B S AN 100 98,

AT LAAE R0 28 0 0 e 1 2% (R 45 5 5

B K WEP #HE WPA 4]
HSRASHOBE N AU WEP 24t WEP 5940
© 10 /e 26 M NHEHIFA . AT EE A -FL a-fF10-9.
2
o 5E 134 ASCI 745 . ASCI FHHLIGFBE, BT AT AL EARFUN T4 -
RSB A LT WPA 55 WPA2 4otk WPA B854 0
o 64 M FNHEBI T, NI TS A-FL a-fA10- 9.

i
e 863/ ASCIl 1. ASCH SHHUIETRE, B3 AT L/ERLE LHRFIF7. WPA 91 ) ASCH
BRSNS

EE: WREAIERER, WS MR 4B A Bk, B 5 2 o 4 44 1N D1 Bk
3

K2 MAC #Huhl

WSR2 AE I T MAC il gEh e, HHYKITEIPLAY MAC Hulik s fn 2 MAC Huikid ygg &, w]
BASCVFAT EIDLAE R 5 . 1 235 78 U0 “ BANFI 4k MAC Hihik? ™ SRHCEZ 115 B

) g 25
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fEH] pinG AR R, BAIARIZE BT LAIE & AR

Windows F /

1 SR SO 1P HuhE.
a il @, sl FFER” , REHd “B1T
b & “JHAMER” 5 “ia17” HEPHIAN cmd.
c f« Enter ##, s “Hig” .
d #i\ ipconfig, SXJ54% Enter .
* Default Gateway (ERIARISC) Tt H i RUMFEA S
o P stk iy 4 ABCAA R AN EUR T, $iltn 192.168.2.134.
2 {fH Ping fiy 2 MliE N\ A
a il @, sl FFER” , KA “B1T
b & “JFHAMER” 5 “ia17” HEPHIN cmd.
c f« Enter ##, s “Hig” .
d AN ping, — T, RGN SN P Mkl .
ping 192.168.1.100
e i Enter f.
3 KA AT Bl
o RN RAFN, EKSEDUTLL Reply from (M5 HD TFLSCF,
AR T BN e TR W 45 o W5 O 0T B T EIAL, ARG F R 22 il 4.
o WIRANEEAIIN, ¥ 2E ] Request timed out Gk ) 7.
W SR LA NI
a iy @, 3Rl TR, REsal ‘BT .
b 7 “JFHHEHR” 5t “i217” HEHHIA ncpa.cpl.
Cc fi% Enter ##, st “Haw” .
d MR IFIR P IEPEIE MM IE R
e fikpaliiEd:, REHl “BR” 5l .

Macintosh (ZEIChR) H M

1 15#6IA AirPort £ H:
M Apple &5 oK IGEFE -
System Preferences > Network
AirPort JRAFE/RIT M iZe 2 (1«

) LA 25
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HE:
o W RIR T H, (HE B E.
o LI RN AR E .
RIEN 1K) 1P HiuhE:
a M Apple & HAR IRIEF
About This Mac > More Info
b 7t Contents X1+ .t Network.
¢ M\ Active Services ¥1|5& H11%E$¢ AirPort.
JEFF X Ik A T AirPort EFE RN E B .
d i3 T Router (Eh#s) HiH.
Router (% rh#%) Tl H i # BN .
i Ping i 2 A FE N A
a M Finder H & IRk $¢-
Utilities > Network Utility > Ping £ i<

b 76 R gk D i NN S 1P Mk {5 -
10.168.1.101

c i Ping.

RGN A RN, SR E BT, Bos WA RUHRIBCRIIN 7 8 IR T SR L A4k
Amit.

UERFEN AT BN, AN BT S #8577 LA ] Network Diagnostics #i5 Bl 45 i vk [ i .

SIS IS AT DURIT BT

Windows F /

1

a b~ ODN

(o2}

SRECFTEIHLIT) 1P Hbdik o

a MITEIHLFTEN—5K P 28 1 L L
WESRCE Z 5 B, WS R A TFH-

b 7 TCP/IP Xidk A& “Huht” .

s @, BE Rl TR, RS “EB1T7 .

E “TFaRR” 8 “1a47” HEPHIA emd.

% Enter 8, si# it “HE” .

W ping, — MM, RJGHIAFTEINLA IP Hutik. 5)tn.

ping 192.168.1.100

1% Enter 2.

7 WERITEIHLA RN, BOR B RT3, Bos WITEIHUESC R 7 K. X mT LU e 4 1 vH 5L T LA

G IFT EDHLEEA T T

WURFITENRLAA RN, #¥4E ) Request timed out GisKiEBEI) 7.
o MITH AT REB T R A

o B RET BRI T ENHLIM B S . I EPHE AT LR E N R
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Macintosh (ZEIChR) H M

1 SRIETEIHLE 1P Hbdil.
a MATEINLAT Bk M 2% R 0L
MESRKPEZ E R, WS T
b 7& TCP/IP X4k “Husk” .
2 )\ Finder H 4k Vi
Utilities > Network Utility > Ping £~
3 {EMIZE HhE D S AT EDHLEY 1P suhil. 4t
10.168.1.101
4 .5 Ping.

5 WARITEIHIE N, BKSEBUTICT, B WFTEIHHEI R 78 X RN RT DURITE
AT EPALEAT 18 R
WIERFTEIHLEA RIS, WA oA 37
o I EALT Be A IEHAE M 2% . 0] LU H] Network Diagnostics 7 B %5 fif ¢ fn) #4 .
o ST HE R R T ENPLI % B . IS EHNZ 1T Wireless Setup Assistant.

ERTHAT SR W E
WIS IO TS W T VRSO T S ERTIATHT EDHLE R . WEP 5 WPA 8541, S s A 4 2
O S S E YN S PIT  SIN

TP AT I 2 BB A ] LUAR P p T G2 IE B A R T 5 R 1) ) 8
HE:
o UURMREMIR MW E, TS A S EOCR s, ARG MUR A SR .
o PRI AL NS FOR T R4 s, IS AE T AT HoA I 2 v B s, ARG A R BALE
W28 o BIX L R A%
Windows f /
1 fidi @ 50 “FFER7 .
2 sl “BTERERT B R, ARG MFIRIERET EIHURR Y SO
3 R FE:
FTEMPLED > IEREMFTEINL > “RE” L0k > TRRBENHARERF
HE: fEded i, nRes i@ H B i f O 4T EPY LAV BN B
4 I ENL R B R S T A

Macintosh (ZE3CHR) FF
1 M Finder "4 Uik £
Applications > P& FIFTEIHL SRk
2 Xt Wireless Setup Assistant.
3 AN A TR ST ERAE
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BOA RIRTCEAT IS5 4%

FESBL R, ISTTRERT B Al B, SR EBLEA S8 LT BRSSP BLRE 7]
DUBAT GHATED, BBl R 1073k

EE N

A O SR

MFATICERITEN I “TOERW” 58
RIS i

VA VT EHURHT ETHLARA & AT P4 A4 2% 1P M

RSB AT A LN, JFER I TR B E, s T B AATEN, T RE /el
AN BE 4 B ) VAR A5 R WORFBCA IR A IK B 4% A0 T A UL, R DUR & K
EER

WIS R T AR, USSR LB, RS IR 3T EY . B0 AR T EDHL TG 2 LA Bk AR I 18] 4 ] BA
SIEH R OIF O I 2k M 2%

UGSy T LG I IR TR 2B AS AR T BN M 2%, (ER RGBT AR R, TR oLk M 2%
HIL T[]

VA WL A HUI RIS T EDBLAR U B T 1P Sk
1 A @, S Rd “FFR” , REnd BT .
2 75 TG ER” B 84T HETPEN emd.
3 i% Enter §#, siF iyl “HhE” .
4 i\ ipconfig, #RJ51% Enter .
IP Muhil b 4 AECF A, HIANBUR 2y JT, #1140 192.168.0.100.

ERFITEINLEY IP k.
o MITEIHLFT B —5K M9 24 1% 5 51
£ TCP/IP X34k “Hubk” .
o HAEFTEIHLILE .
1 7EFTEIMLERAE TR AR I -
& > M E > TCP/IP

2 &4 “Ip k" .

WIRSTEINUR / BREECAS I AT [P didil, = 1P M@ 169.254.x.y (JL x Fl'y 7 0 - 255 Z Al T
PIAECT)

1 RHRAARIP bk ses CECAHK. TEPL. B2t .
2 7T ¥, RIAEFTR A P bk,

) g 5
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U AR A HUIRT /BT EDHL SR AT Bl BAT 240K 1P Mk, mr e M B T ). 1 221

N

o WEFIANERIEA R Cogigtias) BHRIECTTIT, JF HarLUER TAE.

o BITHT v BERH LA 5 4.

o i 5GP B 2% v I AT AN b B JEZ e e, T RIS DT AT RS S M4 2l 9 A SO e 45 A
BRI ER AT, ST ENHLAT T BEAE SCVR A IR TR] P9 BCAT B 21 1P it

o IHHINER) DHCP k554 (thrlRe 2@kt hds) wLUER TAF, JFH&M TRE, w2 IP
Hohiko WRAEANHE WA, 135 2 BRI S A JC et th 4% SR T

A ARATENHLANTH SR A A R 1P sk, JF HLNZE TAR IR, THAREEAT i U2 R AT

TE AR T Jodkim X

i @, BeE R TR, ARERE “IB1T7 .

£ “TFRER” 8 “1217” HEH ¥ control printers.

% Enter B, & Hd “HEE” .

AR ATEDHLIEIbR, ARG SRS sarh ity “ gt B0 “4TEIHLBH” .
ik “BR07 IR

FE B AT A o AT A AT AT S P AR

U SR T ) IR X R e A USB i L, 1 ABIR TR R CHR 7 I T EI L
F7 s e Gk “ATEIHL” DX 3T ENHLAL S, BIATEIE#% 7 IERA 3T BV P LS 1.

8 il “Haxe” . W HH T EL

TEIEAXUEERE R H

i @, BeE R TR, RS “IB1T7 .

£ “TFRER” 8 “1217” HEH ¥ control printers.

% Enter B, &g “HEE” .

AR ATEDPLIEIbR, AR5 SRS sarh ity “ gt B0 “4TEIHLBH” .
Hak “Be07 IR

b “RRAXUSCRE”

R VA > W, RE IR

N O a0 A WON =

N o a0~ O =

HER BRI A M (VPN) I 54T LA E R A B T

AR RN BUEM A PZENVPNYI, 5 B RA L 2% P T AT LI IE R 2 Pk . K2 H VPN H
FVFRL 5 VPN EATIE R, AT DATRIN 5 FOAl R 26 064 T TR 0 SR8 435 B T A TA] I 32 12 280 5 P A 1 o 2 AT
VPN, %k VPN [ R4S HE A 01 a V] Split Tunneling (4 253diE) Dhfg. iR, —ShUW48im T
ZAIBRN A eV LD g .
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AR R TR) B TC ¢ 38 W [ i
FAF RS T I o4 AT FERTBSCE, TRE vE REBUAB AT EDHL TR T — MR, SRAHFLE T TAE
R AR RN T T BL P I AN, S ELATI A LRI A A 2 B 0 v

LR M N, EMNAE R VPN LR

RZBOBMAN NMLE(VPN) R AV SEHLE VPN ZEATI R, ANA] LUR N 5 A P48 3EATI0 R AR TSR B
LARUNENFE P BE AR SR s T e W E AT, 15 VPN BT ISR .

B AT UL S IE AR VPN s 33T TR VPN Client #AFIFR B 1R VPN JEH: . R
2% VPN Client #fF, i#4£ ] Windows VPN Client T2l £ #z .

SRS A BT DRI TP B A 26 70 VPN, 15 285K VPN B R GESCRE A B3 SRV A Split Tunneling
(PEIEIED Dhfg. iR, YA T2 mER N A eV Bt o) Re .

RAEA R okBhas) KHEE, REEHTIT
S A SR, AT EDBUAT VST TERTRR L b . MR T LRI 940 E BT AR e i .

TH B Y 45 L
USRI AN, L FORLATET EHLRT AR TAAE . 04 1 6 4 0 52 R T €04
o BRI R RCH) A
24 02
SR SRR TR
R
T 59 4 R 4 K O S

HER TR

WIS BEH] A T RE 2 TR IT 2 M 25 A TR Z MZ T 2k il (AR THL « By 2L
MAS JLT I R s L o2 AL BE % LS A5 R S LK R AR AT W] e 4 v W Jo 2k I 23 TR
AT XL RE T, HENDE S FECT . mAE, PR AR LL M S S IX R %0 TT

BAR A RAE ] B ARIE

A7 I AT DU A 45 AR N i F T 3R IROPE R B ok AR ROV T4 B i AT 3 NIy (1) 00
B THS YRR R s R SR P A B SRR R = A JARFIIEAE Dy a kTR g, (HREA 2
FIRGENT . WALk th as i B A BN BEE, WA E B, AN AR 0 o W SRAEANR R i
PRI, 15 2 BE R RS AN i S L A0 245 B SR

% F ME—[¥] SSID Br BN S

1135 T4 0 45 L 5 9 050000 i S 0 SSID. I I SSID 119 AW 7 ) — MK 8y
SEITAERY, RN SSID 1 A SFEH I . S 2 o I AE 22 0 e ) A B0, LT EAL
S SHLIT il 22 R B 1 A 2

) g 5

113



UL Gt DU R SRR T, AR IR i L SSID,  ANEAF BRI . R SEANHA A o] 422
SSID, iHZ [ bl [F S RN ml— S SR AL 0 A B SOk

EE: WA U EBCE T SSID,  Bn e T A i I 5 I TC 2 9 2% 1) HoAth Be %242 SSID.

KM TR 4 8 B R4S IP Hibk

KL BOICE Al T2 1% 28 B (1) DHCP (B THL BN AR S5 2% 0 ToLk R 24 v (1) 1 71 23 i 1P i
Hk. DHCP HuhibAE 75 B Ik A 420, 5012450 P ¥ 4598 N 21 G 2k 0 48 v e 24 BE 4 4T T RSN . ok s
2 DA R) % B AR SR, ARG AN 1P dudik, DU AT DIEM R TAF. BT ek thas i 1 20 itk
PASNA 858 AR 22 HAR AT S5, A3 B AT AN S AR e i 3 520 Pl it o 375 3K 8 45 P S e Rl 3 b kit 2 iy
IR T

T 2 R 18 B X 4% TP R # F e R A IP ikl DAAR v I 1) S8

WIS FTEIHLEG & — N ER S IP sl

1 52N BE, RUFTEINLN ML () DHCP 45 g5 #%0s—4> DHCP Hidik.

2 fTEI—SKk NG BEE T, AE M BB 1P Mkt

3 FITFMILR RS, ARG /eI R NFTEDHLAY IP Huhik. % Enter 4.

4 i “TEE > TCP/IP > i EHA IP Huhk” .

5 75 “Hubik” FRCh NGRS EONFTEINL 1 IP Mk, AR)5 R BRI .

A P 288 301 W s A Mk A rh s A |P MU AR ST EDHLIN DO A5 AT BLFT T, B IP stk 15 C8 B,
TR 2 A7 AR E R 1P bk (A BIAE R, 15 2 B Bl R 8 10 i e 25 MHRAE 2R e e SR AL (R 5 B SR

BEERARR TR B

LU A AT WA B, AT B TR R AR A o TR ph A I R 0 A w R . AT
R TR G B A A A R AN E W D7 1) G R M, TS P RE R S A e il
SR B SR .

MBI M 2% E B8 T+ 2

RSB I SRR BT SN LT ED I 2 1 [, 355 AR AL A JC 2k I 2T G a1 A I R Pl 9k B
FREATH RSB RES, ] LA )

R BT A 0 2 0 2 53R O A+ R R SR 2

HURAE R AN TeZe W 28 ha] DL D A 4945 802.11b. 802.11g F1 802.11n #5845, {HEHEHR I BEAAT I 4>
BH 1150 P v £ EA T T TR

R TR RO I8 e, IR A4 e . SR V0T LUV, 5T R 2 T
T 0 TG o 4 T S8 S O 1 10 46
Y 3K —/~ B ) i e

AR PR s D2 TARZ AR, BRI RETCIE S S AR 2 rR AT M o 2 i 2 8 it o 1S5 R8I S — A ]
Loy 802.11 IEEE VG RYEOR K 2% 45 o
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mDNS.tar.gz
Expat.txt
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PRI D
st | L

BERFR

TAFPERAL | 15-32° C (60 -90° F)
s i -40-60° C (-40-140° P>
i A7l 1-60° C (34-140° F)

7= b AL
TH G AR B W A B R 5 R A BT EDHLB e o T A W R L BB LT i A B (B AT 36 75 o

FE Y

=

Uer= L AR R A R, P RERR B BRI AL B A . 1 U I Y il
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/3 /i £ (1115 ..

1 [ RoHS XI5 &

AR A FY) FEITHE
% (Pb) |7k (Hg) |48 (Cd) | /5% (CrVD | 23K (PBB) | 23 — 2K (PBDE)
HLIE B X 0 0 0 o) o)
CEP/ X 0 0 o) o) o)
HLJ £ X 0 0 o) o) o)
TR X 0 0 0 o) o)
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PFUBREC A —HIAL | X 0 0] 0 o) o)
PUBREC A —I 04t | X 0 0 0 o) o)
RGBT X 0 0 0 o) o)
LCD &nht X 0 0 0 o) o)
O: RIRTBLEI I IR T B A5 3R 4 1 % BT SJ/T11363-2006 Al (13 & BRI 22K
X R 2 —Fi )T R b A SR A i T SJ/T11363-2006 HHi (13 3 BRI 22K
B S5 W 4R 4 2002/95/EC H A7 St Ay ) A P R B A o



http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
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A B

AT BT A R A A RESTT A AR, A B AR T IR o “
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o= i Bl 7
AR E N FAREL #h CIFEARRT Rl A RaBR kD e .

TSR RN F W T

I 6 AR S i L B B e {1 SR (R A 2% 5 e (FCC) A HAM AL I UG A - To e M i 2 i (OB bk
(R REFIERAE N D1 2 (R IR BE B 25 R 2220 20 JRK (8 98~ DA A2 FCC MIHAt B N UG A7 S A
UIES AN

Notice to users in Brazil

Este equipamento opera em carater secundario, isto e, nao tem direito a protecao contra interferencia prejudicial,
mesmo de estacoes do mesmo tipo, e nao pode causar interferencia a sistemas operando em carater primario.
(Res.ANATEL 282/2001).

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference
that may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly
prohibited per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit
RF fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cetappareil est conformealanormeRSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes:

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence recue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été congu pour fonctionner uniquement avec I'antenne fournie. L'utilisation de toute autre antenne
est strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pourempéchertouteinterférenceradioauservicefaisant!'objetd'une licence, cetappareil doit &tre utilisé al'intérieur
et loin des fenétres afin de garantir une protection optimale.



Si le matériel (ou son antenne d'émission) est installé a I'extérieur, il doit faire I'objet d'une licence.

L'installateur de cet équipement radio doit veiller a ce que I'antenne soitimplantée et dirigée de maniére a n'émettre
aucun champ HF dépassant les limites fixées pour I'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Taiwan NCC RF notice statement
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